Molecular Electronic Structure Calculations

Introduction

In the last few years, the development of more efficient quantum mechanical algorithms, the increased speed of computer hardware, and the availability of sophisticated graphical software have made electronic structure calculations accessible to the experimental research chemist. Consequently, exploring chemical processes using computer models is becoming ever more commonplace in research, and such methods are becoming an accepted part of the wide range of tools that chemists use to solve problems in chemical research. The integration of such computational techniques into major-level chemistry courses is thus quite appropriate. This assignment introduces you to these techniques through the commercial electronic structure program called MacSpartan Pro®, one of the software products of Wavefunction, Inc., marketed under the general name Spartan.

There are several goals associated with this computer assignment: 1) to provide a brief introduction to how electronic structure methods are performed; 2) to illustrate the types of information one can now learn easily about molecular electronic structure; 3) to confirm some of the electronic structure results presented in lecture and in the text; 4) to show how such techniques can be used to help solve chemical problems; and 5) to stimulate you to think of creative ways in which you might use electronic structure calculations to help solve chemical problems of interest to you.

Electronic Structure Calculations

Performing an electronic structure calculation can be broken down into steps:

1. Preparation of the input data.

Within the Born-Oppenheimer approximation, in which the nuclei are held fixed while one solves for the electronic motion, one must first define the fixed nuclear positions at which the electronic structure calculation will be performed, i.e., one must define a molecular geometry. In Spartan this is done via a graphical interface that allows you to click atoms into place as you build a molecule and specify atomic connectivity.

Most of the calculations you undertake here will use a variational approach in which the molecular wavefunction is written as a single Slater determinant of molecular orbitals (MO), where each MO, in turn, is written as a Linear Combination of Atomic Orbitals—the so-called LCAO-MO method that we discussed in lecture. To begin the variational approach requires a definition of a starting trial wavefunction. In the LCAO-MO method, this requires a definition of the atomic functions that will be used to construct the MOs. Recall our variational approach to the electronic structure of H₂: to begin, we used a trial LCAO-MO wavefunction $\psi$ written as a linear combination of a 1s atomic orbital on H₁ (\(\phi_{1sA}\)) and a 1s atomic orbital on H₂ (\(\phi_{1sB}\)), i.e., we defined the atomic functions that were used to construct the MOs. In Spartan a reasonable collection of such sets of atomic functions is built into the software, and consequently,
selection of an appropriate set of atomic functions is achieved by simply selecting a choice from a menu.

2. **Running the calculation**

MacSpartan is actually a collection of programs, and the type of calculation you request will automatically invoke the correct assortment of these programs. Once you have specified the molecule and the type of calculation, the Submit option under MacSpartan’s Setup menu takes care of launching the other programs in the correct sequence. While these programs are running (a time that for us will be only a minute or so, but that can be hours for very large molecules), the Mac is available for other uses, but sluggishly, because most of the processing time is given to the Spartan programs. When all of the calculations are complete, you will be notified, and you can begin the next (but often not the final) step, analysis of the results.

3. **Analysis of the results**

The results from a molecular calculation include numeric values of energies, atom positions, and other requested properties as well as graphical representations of molecular orbitals or total electron charge densities. The graphical output is very good, and you will find yourself viewing electron densities, exploring the bonding or antibonding character of molecular orbitals, animating vibrational modes associated with nuclear motion, viewing energy-minimized structures, and determining bond lengths or (for polyatomics) bond angles.
Guidelines for Using MacSpartan® Software

Building a Molecule

The first step in an electronic structure calculation is to build a starting structure for the molecule of interest. To build a new structure select New in the File menu. This will name the main window untitled 1:Molecule 1 and bring up the Model Kit floating window. This window has three tabbed panels: Entry, Expert, and Peptide. The Entry tab provides quick access to most simple atoms and connectivities for typical organic compounds, and the Peptide panel does the same for peptide (amino acid) fragments. We will use the Expert panel, shown below.
In this figure, the **Element** box was clicked first to display a Periodic Table (click and hold the mouse down to see the Table, then drag to the element of choice) and select hydrogen, then the “one bond” motif was selected (click on the icon), and the single bond was selected (but it’s the default and usually does not need to be selected directly—in fact, for us, the “single bond” multiplicity will **always** be our choice, even for species like N₂ that are multiply bonded).

Building the structure requires making these selections atom by atom and clicking in the main window to place and connect atoms. For example, to build H₂, click once to place the first atom and see its single unsatisfied bond, then click again at the end of the dangling bond to place the second H. (You may need to click twice at the end, once to extend the bond and once to nail down a second H atom choice. MacSpartan defaults to placing H atoms on any open bonds, so the second click isn’t really necessary, but it’s a smart thing to do because the second click will show the second H atom explicitly.)

Once the molecule is built, you can close the **Model Kit** floating window. The **Model** menu can then be used to change the type of model display. Try a few out, but the **Ball and wire** option is the best for our use later on.

The model can be rotated, resized, and moved around the main window through various mouse/key choices. Just clicking off the model and dragging rotates the model (in a somewhat awkward way—you may have a hard time getting the model back to the position you really want). Holding down the **option** key at the same time translates the model. Holding down the **Apple** key and dragging rotates around axis perpendicular to the screen. Holding both the **option** and the **Apple** keys scales the model size.

**Bond lengths** are measured by first clicking on the ![icon](icon.png) icon in the floating toolbar. The cursor will change to a “ruler” with an arrow. Click on two atoms with the arrow, and the distance between them will appear at the bottom of the main window.

Click the ![icon](icon.png) icon to return the cursor to its normal state.

**Setting-up the Electronic Structure Calculation**

**Introduction**

Once a starting nuclear geometry has been established, the next step is to calculate an electronic wavefunction. This is achieved using the **Setup** menu. Open the Calculations... entry in the **Setup** menu, and the dialog on the next page appears.
Note that we will always want to calculate the equilibrium geometry, we will always use the Hartree-Fock method, and the type of method (the drop-down menu shown as AM1 will change once Hartree-Fock is selected) will vary, as you’ll see. We will also want the program to always “Print” (actually, save to a file) the Orbitals & Energies. Check that option box, then click OK once all the choices are correct.
Selecting the Trial Wavefunction (or Basis) method choice

In LCAO-MO calculations, the choice of the set of atomic functions that is to be used for the construction of MOs is referred to as a selection of the basis set.

The last drop-down menu on the top will have the following choices:

STO-3G  3-21G  6-31G*  6-31G**  6-31+G*  6-311G*  6-311+G**

The STO-3G set of atomic functions is the simplest set of atomic functions that could be used in this type of LCAO-MO calculation. (STO stands for “Slater Type Orbitals,” Gaussian functions that approximate the true atomic orbital functions.) For example, for H₂, this set is a 1s atomic function on H_A and a 1s atomic function on H_B, each with an effective nuclear charge parameter. From an energy standpoint, such a set of atomic functions is the poorest.

The other sets represent a steady improvement as one proceeds down the list. From the standpoint of the variational method, the 3-21G* set of atomic functions yields a better (i.e., a lower energy) LCAO-MO wavefunction than the STO-3G basis, the 6-31G* basis yields a better wavefunction than the 3-21G* basis, and so on. (The names code the number and kinds of basis functions.)

In the companion handout for this lab, you will be told which basis set to choose for each calculation you do.

Initiating the Calculation and Examining the Results

Once the selections have been made, use the Submit entry under the Setup menu to begin the calculation. You will be asked to name your file (actually, you will name a folder that will contain your files for any one molecule). Give each a unique name, saved in the MacSpartan folder. Once you have saved the file, MacSpartan will launch the necessary programs to perform the requested calculation. A dialog box will appear, telling you that the job has been “submitted.” Click OK to dismiss this box. Just sit and wait the few seconds it takes to complete the calculation, and another dialog box will appear to tell you that the calculations are complete. Again click OK.

The numerical results of your calculation will then be available through the Output option of the Display menu. Make this selection, and a window will open holding scrolling text of numerical output.

Saving this text for your later study is not as easy as one might wish. You cannot save it directly from MacSpartan, but you can select and copy it all so that it can be moved to a file which will gather all your output form this lab.

Open Microsoft Word (or switch to Word if it is not already open on the computer) and create a new document. Use the Document entry in the Format menu to set the document’s margins to 1 inch all around. Save the document under a unique name (and add the “.doc” prefix to your file name for use on Windows machines—you will
email this file to yourself and your lab partners). Switch back to MacSpartan, select all the output, copy it, switch back to Word, and paste it all into your document. Select it all in Word, and set the font to Monaco, 9 point. This choice and the margins you set earlier should allow the pasted output text to fit nicely on the page.

Save your collection document after each paste; sometimes MacSpartan or even Word can fail and lock up the computer!

Guidance on how to read and interpret the output text file appears in the companion handout for this lab, but a useful summary of some important information comes from selecting Properties from the Display menu. This will bring up a floating box such as the one below, taken from a MacSpartan run on HeH⁺.

![Molecule Properties](image)

This box shows the final energy (in atomic units, hartrees, with a note as to the basis set used, STO-3G in this case), and several other useful bits of data. The (aq) entry will not concern us (it corresponds to an option to calculate an aqueous solvation energy), but the HOMO and LUMO entries will. They give the energy of these two important orbitals: the Highest Occupied MO and the Lowest Unoccupied MO. The Pt Group entry gives the symmetry point group of the molecule (Civ here stands for the real point-group name, C∞v, which may make no sense to you if you haven’t yet taken Chem 64!) Weight is molecular weight, and Area and Volume won’t concern us. The Dipole moment is in debye units, and the Read-Only option won’t interest us.

As we’ll see later on, this floating window changes when we are viewing wavefunction images, to which we now turn.

**Calculation of Additional Molecular Properties**

Once the quantum calculation is complete, you will ask MacSpartan to compute various graphical versions of the calculated wavefunctions. You will display these, and
you can save these images in your collection document for later incorporation in your lab writeup.

The pictures you will want to generate and study will vary from molecule to molecule, as explained in the companion handout. But the process you follow to generate them will always follow these steps.

First, use the **Surfaces** entry under the **Setup** menu to display the Surfaces floating box. This box has an **Add** and a **Delete** button that are used to select (or later delete) a particular wavefunction picture. Click the **Add** button to bring up the **Add Surface** dialog box shown below.

![Add Surface Dialog Box](image)

You will select the wavefunctions to observe using the **Surface** drop-down menu, as instructed in the companion handout. The other options on this dialog box won’t concern us. Once you have made your **Surface** choice, click **OK** and return to the Surfaces floating box to **Add** more surfaces, one at a time, until you have selected all that you need.

You generate the image data through another **Submit** command from the **Setup** menu. This will launch the program that calculates image data, just as the quantum calculation programs were launched earlier. When you are told that the calculations are done, you will return to the Surfaces floating box to display, one at a time, images for your selected wavefunctions. You can use the mouse cursor to rotate, expand, or move these images just as you did for the molecular models; the wavefunction image will appear directly over the model image. For example, here is the model image for HeH\(^+\) and the image of its LUMO. (Helium is on the bottom.)
Note that the images are actually in color, not in shades of black, as they appear here if you are looking at a black and white photocopied version of this handout! Your final writeup will likely have one or more of these figures in it, and you can either email the entire report to me (as a Word document or a pdf file, if you can generate such a thing easily) or print it on a color printer.

Once you have an image displayed and oriented as you wish, you can use the Copy command in the Edit menu to copy it, then switch to your Word collection document, click on the Paste Special entry in the Word toolbar (or under the Edit menu in Word), and deselect the “Float over text” option in the Paste Special dialog box, then click OK. These last few steps simply make the images go into the Word document in a little simpler and better formatted way. Save (but don’t close until the very end of the lab) your collection document after each paste.

Completing One Molecule and Starting Another

Once you have all the information and images for any one molecule, select Save in MacSpartan’s File menu, then Close the file from this menu (there is no “close box” for the main window). Start the next molecule with a fresh New command, build it, set up its calculation parameters, submit the calculation, name the molecule file, and analyze the output. When you are all finished, save and close your Word collection file, switch to BlitzMail, and email this file to yourself and your lab partners. Details on your writeup appear in the companion handout.

Finally, note that the Mac you will use has tons of memory, and all the applications you will need for this lab can be opened at the same time without difficulty. Don’t bother quitting any of the applications.